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Chapter 1 Profile 

1.1 Introduction  

 

This system controls a laser CNC machine by computer and completes machining tasks according to different 

settings from the user. System consists of a control system, control panel and compatible software. This manual is an 

introduction on how to use the software to complete machining tasks. 

 

1.2 Composition  
 

The control system consists of hardware (control card) and software. Hardware includes one motion control card, 
two connection cables, and laser control software. Control system software and instruction manual are in the CD 
within the packaging box. 
 
Table 1 Software Content & File Specification 

Files or subdirectory 

name 
Content Instruction Manual 

LaserCAD folder 
Installation procedure of control 

system Copy 

  

Table 2 Composition of Hardware equipment 

Project Quantity Instruction 

Control card 1 pcs USB port、Network port、U disk port 

LCD Panel 1 pcs Size: 150mmX100mm 

cable 4 pcs 

USB cable、USB extended cable、

network cable、 

Panel connection cable 

   

 

1.3 Software Versions 

  

Included are three versions: General Version (LaserCAD) ，CorelDraw based version, AutoCAD based version. 

 

1.4 Software Features 

 

 Friendly interface, easy to learn, simple to operate. 
 Compatible with AI、BMP、PLT、DXF、DST formats 
 Can create simple graphics, characters and edit & layout imported data. 
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 Can machine by layers and define output sequence. 
 Customized settings of working procedure and precision, simulation shows the running trial of laser head. 
 Multiple functions of Path Optimization and pause function during execution. 
 Can save images and working parameters that can be reused. 
 Estimates working time and cost budget, intelligent input. 
 Array input, immediately output and go back to origin to output orientation mode. 
 Unique double laser systems working intermittently, working independently and motion trial with function of 

offset and control  
 Set the working start point, working path, dock position of laser head according to different requirements. 
 Compatible with multiple communication modes. User can use USB communication and network 

communication according to situation. 
 Supports CorelDraw direct output version, AutoCAD direct output version. 
 Can continue unfinished work after an unexpected shut down. 
 Support 4 axes: X, Y, Z, U, Z-axis is used for elevation and U-axis is used for feeding. 
 Autofocus, no need to adjust the focal distance between laser head and object, convenient to new user. 
 Engrave photograph directly, support rotating engraving, protect various communications, with two limit 

ways: software limit and hardware limit 
 Support slope engraving, main board online upgrade, all capacity and branded U disk. 
 

1.5 Operating System Environment Requirement  

 

 ⑴ Run on Windows( Window2000、Window XP、Vista、Win7 ) system 

⑵ Celeron 2.1G above 

⑶ Suggest using 1G above memory. 

Chapter 2 Installation 

2.1 Installation Steps 

 

Navigate to installation directory: 

 

Double click Setup.exe: 
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Click【Install/安装】: 

  

 After confirming installation path, click 【OK/确定】. After installation, it will ask if you need to continue to install 

USB driver. 

 
Click【是(Y)】： 

 
Click【OK/确定】, the installation is done successfully. 

 

2.2 Cautions  

 

（1） Some antivirus software will consider the file “LaserCAD/Setup.exe” in the installation directory as virus. 

Please make sure the antivirus software will not delete this file.  

（2） If the file “LaserCAD/Setup.exe” is damaged, below dialog will be displayed during installation： 

 
     If this happens, please go back to get “LaserCAD” installation package again. 

Chapter 3 Basic Operation of LaserCAD 

3.1 Main Interface 

 

After starting up the software, you can see the interface shown below. Being familiar with this interface will be the 

basis of using this software to do laser machining.   
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【Menu bar】：Menu bar includes 7 functions like file, edit, draw, tool, options, view and help. 

【Tool bar】：There are some functions completed by commend buttons in tool bar. Most of these functions are 

sorted from menu bar. 

【Object bar】：Allows selecting object during operation and relevant properties during using tool. It can control 

the change of object by setting relevant properties in property bar. 

【Draw bar】：Located to the left of the working area. With draw tool in draw bar, it makes operation more 

flexible and convenient. 

【Align bar】：Aligns multiple objects to perfect the layout of page. 

【Color bar】：Alter the color of selected object 

【Control panel】：Use control panel to finish several tasks of laser machining, including setting communication 

IP, setting layer parameter, loading graphic and so on. 

 

3.2 Select Communication Mode 

 

 Computer can communicate with AWC608 control panel via USB and network to operate the laser machine. If 

the communication mode is not setup correctly, user operates laser machine by this software, then the following 

Align bar 

Menu bar 

toolbar 

Object bar 

View zone 

Draw bar 

Control panel 

nel 

Color bar 

Status bar 
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pop-up will show: 

 
 

3.2.1 Select USB Communication Mode 

 

3.2.1.1 Steps of selecting USB communication mode 

 
Click【Select mode】: 
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Click【USB mode】: 

 

Next setup USB communication port, double click : 

 

Name【Device Name】as “Machine 1”, (Firstly use USB cable to connect computer with control panel) and then 

click【FindCom】: 

 

Click【OK】: 
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Now the USB communication mode is selected and machine name is “Machine 1”, USB communication is “4”. 

Click : 

 

The process of 【Select USB Communication Mode】is completed. Now user can use USB to control machine by 

computer. 

 

3.2.2 Select Network Communication Mode 

 

    Follow the steps below to achieve network communication between computer & control panel:  

 （1）Input correct network mode and machine’s IP into software. (Please refer to 3.2.2.1) 

 （2）Set correct IP for the computer. 

         Using network cable directly to computer (please refer to 3.2.2.3) 
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         Using modem with cable (please refer to 3.2.2.3) 

After applying the settings of the 2 steps above, it is possible to control the machine operation per to network by 

computer. 

3.2.2.1 Steps of Selecting Network Mode  

  

Click【Select Mode】: 

 

Click【Network Mode】: 
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Set the IP for the machine, double click : 

 

 

Name【Device Name】as “Machine 1”,Set【IP address】as the IP shown on LCD Panel: 

 

Click【OK】: 
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Now network mode is selected with device name “Machine 1”, machine IP“192.168.8.8”, Click : 

 

The process of 【Select Network communication mode】is completed. 

 

3.2.2.2 Using network cable and control panel to do network communication directly to continue computer IP setting  

    Step 1, Check control panel IP on the LCD Panel. 

Enter LCD Panel【Menu】->【Network Config】 
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     Find control panel IP ：192.168.8.8. 

 

Step 2 Set computer IP according to control panel IP of LCD. The computer IP must be the same as the first 3 

numbers of control panel (Current first 3 numbers of control panel IP is 192.168.8), the last number is 

different, (The last number of control panel IP is 8), so according the control panel IP from step 1, set 

computer IP to be 192.168.8.X (X can be any number that does not equal 8 and no larger than 255) 

Such as: 92.168.8.9; 192.168.8.10… 

       

            Steps for setting computer IP to 192.168.8.10 as below: 

      Enter into Network Places  

          

 Click <View network connection>     
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   Double click <Local Area Connection> 

    

   Double click【Internet Protocol (TCP/IP)】: 
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Select <Using following IP address>, set <IP address> as192.168.8.10, set <subnet mask> 

as255.255.255.0 ： 

 

Click <OK> to finish computer IP setup. 

3.2.2.3 Computer IP setting by network communication using network cable and control panel via router. 

 

 

Step 1, Set computer to obtain IP Automatically. 

    Enter into Network Places            
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      Click <View network connection> 

    

   Double click <Local Area Connection> 
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   Double click【Internet Protocol (TCP/IP)】 

    
Select <Obtain an IP address automatically>: 
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Click <OK> to finish computer IP setup 

Step 2, Check current IP  

    First connect computer to router via cable, so that the IP can be checked 

    Steps as following: 
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  Check the current computer IP as 192.168.8.100 

Step 2 Set control panel IP according to computer IP. The control panel IP must be the same as the first 3 

numbers of computer IP (Current first 3 numbers for computer IP is 192.168.8), the last number is 

different, (the last number of computer IP is 100), so according to the computer IP got from step 1, shall 

set control panel IP to be 192.168.8.X (X can be any number that does not equal 100 and no larger than 

255) 
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   Steps to set control panel IP to be 192.168.8.101 

Enter LCD Panel【Menu】->【Network Setting】 

    

   Click【OK】to enter into sub interface and set control panel IP. 

3.3 System Options 

 

 

Click【System options】or : 
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5 sections included in 【System options】: 【Work Space】、【Advance Functions】、【Work Parameters】、

【Manufacturer Parameters】、【User Parameter】。 

 

 

 

 

 

3.3.1 Work Space 

 

 View 3-3-1 
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【Nudge Offset】:Offset distance when using “←”，“→”，“↑”，“↓”to move selected object 

【Paste Offset】:Offset distance when copy the offset distance of selected object, and paste to current view 

【Language】Current using language 

【Speed Unit】:All units used in the software 

【Machine Zero】:current Zero position of machine(Limit position),the setting must be exactly the same with the 

actual machine zero position, or the machined image could be left/right reversed or up/down reversed. 

【Selected Color】:Color of selected object 

【Show Grid】:Once selected, view shows grid as below 

 

 

 

【Grid Distance】：Grid distance shows in view 

【Simulating show objects of engraving】：System will simulate and show the engraving image layer by filling. 

However, if the data volume of engraving image is too big, system will react quite slowly when showing the view 

by filling. So suggest not selecting the option in common use. 

Drawing shown as below: 



LASER ENGRAVING&CUTTING CONTROLLER AWC608 

 24 

  

【Always show the welcome screen at launch】: when selected, welcome screen will be shown once the 

software is started. 

 

3.3.2 Manufacturer Parameters 

 View 3-3-2 

3.3.2.1 X/Y/Z/U- Axes Parameter (Z axes: Elevating axes; U- axes: Feeding axes) (Refer to View 3-3-2) 

   Click on [Z/U-Axes Options], permits setting parameter of Z axes and U axes 

【Pulse Unit】:When sending a pulse to the motor, the absolute distance moved by the corresponding axis (unit: 

um). If the pulse unit setting is not correct, the processed image size will be different from the actual size. 

【Pulse Edge】: Trigger edge when motor is rotated by motor driver。If the pulse edge setting is not correct, may 

lead to cutting dislocation 
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【Datum】: Axes moving direction when reset。When the axial resetting movement direction is not consistent with 

the shaft limit switch, modify this parameter. 

【Key Direction】:LCD Panel key movement direction. When the direction is different from movement, modify this 

parameter 

 【Range】：Machine workbench range; the max movement distance of corresponding axes. 

【Start Speed】：Start speed of axes from stationary state. The greater the value, the faster the speed, then 

causing bigger Stop dithering, need to make reasonable adjustment according to the characteristics of 

mechanical. The typical setting should be within in 5 ~ 20 mm/s. 

【Max Acc.】: Acceleration when axis making accelerated or decelerated movement. Too a big setting may lead 

to motor losing steps or dither; too small setting may cause slow acceleration and then slow 

processing speed for whole image. For axis with big resistance, such as Y axes corresponding 

with beams, typical setting should be within in 800～3000mm/s2 ; For axis with small resistance, 

such as X axes corresponding with carts, typical setting should be within in 10000～

20000mm/s2; 

【Max Speed】: The motor drive ability and resistance of moving axis decides the max speed that motion axes 

can reach. During engraving process, engraving speed can not surpass the max speed value 

corresponding with the engraving axis; During cutting process, the resultant speed can not 

surpass the min speed of X and Y axis. If speed setting is too large, controller will limit the 

speed below max speed automatically for protection. 

 

3.3.2.2 IO Function Switch (Refer to View 3-3-2)  

 

【Water Protect】:The water protection ports of AWC608 control panel are Laser1.Protect and Laser2.Protect。

When【Water Protect】is selected, system will apply real-time monitoring water protection signal of the 

2 ports.  If either of the port signals gets too high a level, processing job will be suspended, and laser 

will be closed. Meanwhile “Water protect” will be shown on LCD Panel. 

【Open Protect】:The open protect port of AWC608 control panel is IN1.When [Open protect] is selected, system 

will apply real-time monitoring protection signal of the port.  If the port signal comes to be too low a 

level, processing job will be suspended; when the port signal comes to be a higher level, suspended 

job will continue. 

【Foot Switch】: The foot switch port of AWC608 control panel is IN2.When [Foot Switch] is selected, system will 

apply real-time monitoring protection signal of the port.  If the port signal changes from a high level to 

a low level, processing job will be suspended or suspended job will continue. 

3.3.2.3 Laser Parameters (Refer to View 3-3-2) 

 

 [Laser Mode]: Choose the parameters according to the external laser. The current lasers are mainly of 3 kinds: 

domestic glass tube, RF laser (don't need burning pulse) and radio frequency laser (need burning 

pulse). 

 

【TTL Level】:Choose the parameters according to external laser power supply switch signals, AWC608 laser 

switch signals corresponds with Laser1.TTL and Laser2.TTL.If [Low level effective] is selected, when 

laser is on, the system will output the two signals for low level; when laser is off, the system will 

output the two signals for high level. If [High level effective] is selected, when laser is on, the system 
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will output the two signals for high level; when laser is off, the system will output the two signals for 

low level. 

【PWM Frequency】: Pulse frequency of control signal used by external laser. General setting will be within 

20000~80000.  If setting is too small, it will lead to unbalanced power with “Heavy Point” appearing 

during processing. 

【Max Power】: Limit power value that can be set for laser, namely during operation.  The power set by user 

cannot be above this value. 

3.3.2.4 Function config (Refer to View 3-3-2) 

 

【XY axis home On Power 】: If selected, when machine starts, X axis and Y axis will run reset movement 

simultaneously (Shall select the option normally) 

【Z axis home On Power】: If selected, when machine starts, Z axis will run reset movement   (Shall not select 

the option normally) 

【U axis home On Power】: If selected, when machine starts, U axis will run reset movement.  (Shall not select 

the option normally) 

【U axis for feeding】: If selected, start U axis feeding function. If it’s not selected, U axis feeding function will not 

work. (Shall select the option normally) 

【Hardware limit】: If selected, system will apply real-time monitoring on limit signal according to the direction of 

the movement. When detecting a limit signal as low level, ongoing work will suspend, and 

“Reach limit!” will be displayed on the LED. 

【Return origin after work】: If selected, system will return to origin after job completes.  Not selected, system 

will stay in place after job completes. 

 

3.3.2.5 Manufacturer parameter import and export (Refer to View 3-3-2) 

 

 Filename extensions for parameter files is cf5 

Manufacturer parameter import: allows import manufacturer’s complete setting parameter files. 

Click [Import] and then import manufacturer parameter. 

Manufacturer parameter export: allows copying the current parameter settings. Click [Export] and then export 

current parameter. Moreover the exported parameter can be used to modify the current main board parameter 

through AWC608 main board U disk port. 

 

3.3.2.6 Manufacture Parameters Read and Save (Refer to View 3-3-2) 

 

 Filename extensions for parameter files is cf5 

Manufacturer Parameter reading, namely, read and input the saved control panel parameter into the software 

interface. Click [Read] 

Manufacturer Parameter saving, namely, save the software interface settings into control panel RAM, and give 

control panel correct settings. Click [Save] 

If you do not click [Save] after setting the parameters, the settings will not be in effect. 
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3.3.3 User Parameter 

  View 3-3-3 

3.3.3.1 Work Control Parameters (Refer to View 3-3-3) 

 

  [Space Speed]: During work, the max operation speed of laser head when laser off. 

                  The value range of this parameter is limited to Axis [Max Speed] of manufacturer parameter, 

shall not be bigger than max speed of the manufacture parameter. 

[Start Speed]: Start speed during processing, the value range of this parameter is limited to Axis [Start Speed] 

of manufacturer parameter, shall not be bigger than max speed of the manufacture      parameter. 

[Speed Factor]: Factor determining the turn speed in work. The bigger the factor is, the faster the work-speed is. 

Then bigger dither accordingly. Value range between 0~5, normally set at 2. 

[Space Jerk]: Speed of acceleration during space process. The bigger the value is, the faster the space is; 

results in a bigger dither accordingly. Value range is between 10000~60000 normally. 

[Cut Jerk]: Speed of acceleration during cutting process. The bigger the value is, the faster the cutting is; results 

in a bigger dither accordingly. Value range is between 5000~50000 normally. 

  [Min Acc.]: Min acceleration of axes movement during processing. 

[Cut Acc.]: Max acceleration of laser head movement during processing when laser on. 

           Normally set below 1500. 

  [Space Acc.]: Max acceleration of laser head movement during processing when laser off. 

           Normally set below 2000.   

 [Engrave ACC.]: Max acceleration of laser head movement during processing when engraving. Normally set 

above 8000.  Too small a setting will lead to too long a distance before initial speed accelerates to 

engraving speed, causing a failed engraving because of out-of-range. 

  

  3 typical groups of [Work control parameters] for users’ reference： 

  

  



LASER ENGRAVING&CUTTING CONTROLLER AWC608 

 28 

  

3.3.3.2 System config parameters (refer to View 3-3-3) 

 

【XY Home Speed】: Speed for machines’ returning to origin, normally is set at between 40~80.Too big setting 

may leading to big impact onto the limit switch which could break the switch. 

 【Z Home Speed】: Speed of Z-Axis (Elevating axes) returning to origin 

 【U Home Speed】: Speed of U-Axis (Feeding axes) returning to origin 

 【Z Work Speed】: Speed of Z-Axis movement during work 

 【U Work Speed】: Speed of U-Axis movement during work 

 【Key Move Speed】:Speed of keys’ movement on LCD Panel 

 【Run box Speed】: Speed of moving along the image outline. 

 【Clip box Speed】: Speed of cutting image outline. 

 

3.3.3.3 User parameters import and export (Refer to View 3-3-3) 

 

Filename extensions for parameter files is cf5。 

User parameter import: allows import User’s complete setting parameter files. 

Click [Import] and then import user parameter. 

User parameter export: allows copying the current parameter settings. Click [Export] and then export current 

parameter. Moreover the exported parameter can be used to modify the current main board parameter through 

AWC608 main board U disk port. 

 

3.3.3.4 User parameters read and save (Refer to View 3-3-3) 

 

Filename extensions for parameter files is cf5。 

User Parameter reading, namely, read and input the saved control panel parameter into the software interface. 

Click [Read] 
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User Parameter saving, namely, save the software interface settings into control panel RAM, and give control 

panel correct settings. Click [Save] 

If you do not click [Save] after setting parameters, the settings will not be in effect. 

 

 

3.3.4 Advanced Function 

  View 3-3-4 

3.3.4.1 Rotate Engrave (Refer to View 3-3-4)   

 

【Enable Rotate Engrave】: If selected, will make the outputting data of common engraving to be automatically 

shifted to rotate engrave data, so as to realize the function of rotating engraving. 

【Rotate axis con(um)】:When setting X-Axis as the rotation axis, engraving method must be [one-way vertical] or 

[two-way vertical], set Rotate axis control to be value of X axes pulse unit. When setting 

Y-axis to be rotation axis, engraving method must be [one-way Horizontal] or [two-way 

Horizontal], set Rotate axis control to be value of Y axes pulse unit. 

【Step per rotate (pulse) 】: Pulse numbers required from motor driver when rotation axes makes 1 cycle 

【Current diameter】： Diameter of engraving objects. 

  

  Parameter settings for rotate engraving shown below: 
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3.3.5 Work parameters 

View 3-3-5 

 [Curve Disperse]: Curve smoothness setting. The smaller the value, the bigger accuracy the image is, but will slow 

the computation speed, and affect the process speed. Generally choose small value for organic 

glass cutting, other cutting use the default value as 0.10 

[Circle Speed]: The system will automatically recognize whether processing objects are circles with speed limit, and 

then according to the diameter of circle, use the current set speed limit to process the circle. If 

parameter is set properly, it will greatly improve the circle cutting quality. Click the【 add 】 and 

【 delete 】 and 【 modify 】 to set this parameter. 

Current setting of [Circle Speed]  means: 

(1) Circle diameter less than 5mm, processing speed to be 10mm/s 

(2) Circle diameter between 5~10mm, processing speed to be 20mm/s 

(3) Circle diameter more than 10mm, there is no processing speed limit, and equals to speed set in the 

parameter 

[Engrave Reverse offset]: When applying two-way engraving image, it may cause the edges of the scanned image 

not to be smooth due to mechanical return gap. So this is corrected by increasing reverse offset. 

Specific speed has the specific reverse clearance. Generally, the greater the speed is, the bigger 

the reverse clearance is. Reverse gap value can be positive or negative. 

Current setting of [Engrave Reverse offset]  means: 

(1) When speed is 200 mm/s, reverse offset is 0.30mm;If speed is smaller than 200mm/s,reverse offset is in 

proportion to speed. Namely, when speed is 100mm/s, reverse offset will be 0.30*(100/200) =0.15mm。 

 (2) When speed is 300 mm/s, reverse offset is 0.50mm; If speed is between 200~300mm/s, reverse offset is in 

proportion to speed. Namely, when speed is 250mm/s, reverse offset will be 

0.30+(300-250)/(300-200)×(0.5-0.3)=0.40mm。 
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(3) When speed is bigger than 300 mm/s, reverse offset equals the value when speed is 300mm/s( 0.50mm) 

 

3.4 Open & Save Files  

 

 The files used by the software is pwj5 format, the pwj5 file save the image information, all layers’ processing 

parameter, and all image elements processing sequence. You need to save all imported image data as pwj5 format, 

so make it easier for the image processing afterwards. 

 

3.4.1 Open File 

    (1)Click [Open] option in [File] menu, or click icon, and open dialog box as below: 

   

    (2) Select the file needed (etc. 111.pwj5), then click [Open]. 

3.4.2 Save File 

    (1)Click [Save] option in [File] menu, or click icon, and open dialog box as below: 
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     (2) Input file name in the edit box, then click [Save] 

 

3.5 Import & Export Files 

 

As the file format used in this software is pwj5, importing is required when you need to make or edit image in another 

format, and exporting the current file to another image so that it can apply to other software. Supported importing 

formats are dxf, ai, plt, dst, dsb and so on; Exporting format supported: plt. 

 

3.5.1 Import file 

Click [Import] option or (Ctrl+I) in [File] menu, or click  icon, and open dialog box as below, 

Select corresponding file and click [Open] 

 

[Unite Lines]: Apply unite lines setting when importing the image. (Introduction of [Unite Lines], please refer to 

3.13.5)  

[DST,PLT Auto Smooth]: Apply auto smooth setting when importing the image. (Introduction of [Auto Smooth], 

please refer to 3.13.3) 

[Auto Order]: Apply auto order setting when importing the image. (Introduction of [Auto Order], please refer to 

3.13.2) 

    [PLT Unit]: Indicate the dimension of one unit in PLT file, different values make different importing image 

dimensions.  

   [Reserve the current document]: Upload data of imported file while keeping the original image data. So after 

importing, the image includes both the original data and the imported file data. 

[Preview]: Preview the file image when selecting the file. 

 

3.5.2 Export File 

 

Click [Export] option or (Ctrl+E) in [File] menu, or click  icon, and open dialog box as below, 

Input file name and click [Save]. 
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3.6 Create Basic Graphic & Edit Node 

 

3.6.1Create Basic Graphics 

 

◆ Draw straight line 

Click [line] option in [Draw] menu, or click .  Drag the mouse on screen to draw any line. 

Press “Ctrl“ key and drag the mouse at the same time to draw horizontal line. 

 ◆ Draw polyline 

Click [Polyline] option in [Draw] menu, or click .Drag the mouse on screen to draw any line. 

 ◆ Draw Bezier 

Click [Bezier] option in [Draw] menu, or click .  Drag the mouse on screen to draw Bezier. 

◆ Rectangle 

Click [Rectangle] option in [Draw] menu, or click .  Drag the mouse on screen to draw rectangle at any size.  

Press “Ctrl” key and drag the mouse at the same time to draw square. 

 ◆ Ellipse 

Click [Ellipse] option in [Draw] menu, or click .  Drag the mouse on screen to draw ellipse at any size.  

Press “Ctrl“ key and drag the mouse at the same time to draw circle. 

◆ Edit text 

Click [Text] option in [Draw] menu, or click .  Double click on the left mouse button, and open dialog box as 

below: 

  

Choose font, input or select font size, input text and then click [OK]. 

 

3.6.2 Edit Node 

Click [Node Edit] option in [Draw] menu, or click .  Then tools （Add node） （Delete node） （Connect 

node） （Separate node） will be shown in the object operation bar. 
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◆ Select Object 

   Click the object to select it. Nodes of selected object are shown with “ ”. 

   One selected rectangle is shown as below: 

        

 ◆ Select point of object 

Click the selected object, that is selecting one point from object, shown as below in “ ” 

     

 

 ◆ Select node of object 

Click a node of the selected object, that is selecting one node shown as below in“ ” 

      

Remark: Click a node of the selected object and press “Shift” to select multiple nodes of objects. 

 

◆ Add nodes 

Select a point from the selected object as shown below: 

     

  Then click 【add node】of 【Edit】in menu, or click  in object operation bar, the selected node is the added node 

of object shown as below: 

 

◆Delete node 

Select one node of the selected object as below: 

      

Select a point 

 

The selected point turn to a node 

 

Select a node 

 

Select a point 

 

Select a node 
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Then click 【delete node】of 【Edit】in menu, or click  in object operation bar, that is deleting the node shown 

as below:  

      

 

◆ Cut node 

Select one node of the selected object as below: 

 

      

Then click 【cut node】of 【Edit】in menu, or click  in object operation bar, that is cutting the node shown 

as below:  

 

      

    

◆ Connect node 

Select beginning node and ending node of the selected object as below: 

        

Then click 【connect node】of 【Edit】in menu, or click  in object operation bar, that is connecting the node 

shown as below:  

 

      
 

3.7 Select Object 

 

The node has been deleted 

 

Select a node 

 

The node has been separeted 

 

Two nodes have been united as one 
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 During the process of drawing and editing a graphic, you first need to select an object. When an object is 

selected, there is a mark “×” in the center of the object, 8 control points around and profile color as 【color of selected 

object】 (color of selected object】see 3.3.1) 

Click 【select】of 【draw】in menu, or click  in edit tool bar, to switch to “Select”.  Now you can select object.  

Following are 5 ways of selecting objects. 

◆ Click 【Select all】of 【edit】in menu (shortcut key Ctrl+A ) to select all objects. 

◆ Click to select single object 

Click an object to be selected, that is the object is selected shown as below: 

 

◆ Box Selection 

Press the mouse and drag, all contacted objects will be selected. 

◆ Add/Deselect selected objects 

        Add object: Select the first object, then press ”Shift” then click or box select the objects you want to add. 

Deselect object: Press ”Shift” then click or box select objects already selected, then the objects will be 

deleted. 

◆ Select by layer color 

     Click  in objects operation bar, open dialog box as below: 

     

 

 Select the color of objects, and then click【Ok】，then all objects with the layer color will be selected. 

 

3.8 Object color 

 

 Object color means the color of object drawing. Click any color of 

 in layer bar to change object color. 
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3.9 Object Transforming 

 

  Objects transforming is mainly operations to change the objects’ position, direction, size and such, and will not 

change the object shape and its character. 

 

3.9.1 Mirror 

 

    Mirror means flipping objects horizontally or vertically 

 Click , will flip object horizontally. 

Click , will flip object vertically. 

3.9.2 Tilting and Rotating of Object 

 

 Tilting and rotating objects is very simple. 

◆ Rotating Objects 

 2 methods can be used to rotate object: 

(1) Click , and input rotate angle in ，then click  to complete rotation. 

(2) Click , and double click objects needed tilting or rotating, then get into rotating/tilting editing mode. At this 

mode, control points around objects changes to rotation control arrow and tilting control arrow shown as 

below 

 

Move mouse to control arrow, and move control point along arrow direction; during movement, profile line 

generates and rotate as below: 

 

Release mouse when rotating to correct position, then rotation is complete. 

◆ Tilting Objects 

  Operation is the same as rotation. 
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3.9.3 Object Size 

Most simple operation to zoom or change the size of objects is also using ,click the object, and move the 

control points around objects, then allows to zoom object. The operation is simple, direct but with low accuracy. 

Click  and input horizontal size value and vertical size value in the text box，and 

then press “Enter”, and object size is changed。Click to ，then horizontal (vertical) value will change 

accordingly when vertical (horizontal) value is changed. 

 

3.9.4 Array clone 

Click to select operated objects. Then click ， open dialog box as below： 

 

Input 【X Count】，【Y Count】, 【X Offset】，【Y Offset】, then choose direction and click [OK] 

 

3.9.5 Move object to origin 

 Click ，and select operated objects。Then click  

     

3.10 Object Aligning 

Select several objects and click .  Rendering shown as below when using  

 
3.11 Objects Group 

 

 Use “Group” command to join objects together, to operate and edit as one whole unit. 

Group operation is very simple. 
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 （1）Click and select operated objects. 

（2）Click [Group] in [Edit] menu (Hotkey: Ctrl+G);or click ,then operation is done. 

（3）Grouped objects will operate as whole unit, when moving one object, other objects in group will also be 

moved. 

As a whole unit, grouped objects could be grouped again with other objects. Click （Ungroup）and (All 

ungroup) can get rid of group relation of selected objects. 

 

3.12 Zoom 

 

 ◆ Click [Edit]/ [Zoom]/ [Zoom], or click  on tool bar, then click left mouse button too zoom in, or click right 

mouse button to zoom out. 

◆ Click [Edit]/ [Zoom]/ [Zoom to selected], or click   on tool bar, allow a full view of selected object. 

 ◆ Click [Edit]/ [Zoom]/ [Zoom to all objects], or click   on tool bar, allow a full view of all objects. 

 ◆ Click [Edit]/ [Zoom]/ [Zoom to page], or click   on tool bar, allow a full view of page. 

 

 

 

3.13 Tool 

 

Below tools are used frequently in software processing. The use of these tools will make the current image better 

well-organized and faster for outputting. 

 

3.13.1 Manual Order 

 

User can use [Manual Order] to set cutting serial number for each object, cutting start point and finish point. 

Click [Tool]/ [Manual Order], then [Manual Order] window will show at the left side of main interface shown below: 
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◆ Change serial number of object 

（1）Drag items in the [Manual Order] with mouse, allow to change the item to top of cursor. 

（2）Double click the item in the [Manual Order], will move it to the top 

(3) Click [Rev-Order] will reverse all items. 

Note: Items listed in the [Manual Order] window is related to the serial number of the corresponding 

objects. The closer to the top the item is, the more prior the corresponding object is to be processed. 

◆ Change cutting start point of object 

Cutting start point shown as “ ”, click the object and change the cutting start point. 

◆ Change cutting direction of object 

Cutting direction is shown as “ ”.The direction of arrow shows the cutting direction. Click [Manual Order]/ 

[Rev-Order] allows reversing the cutting direction. 

 

3.13.2 Automatic Order 

 

[Automatic Order] is used to set the objects order automatically in the current file. After automatic order, the 

processing routine will be the shortest theoretically. 

 

Click [Tool]/ [Automatic Order], open dialog box as below, and then click [OK]. 

Staring point 

 

direction 
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【Order by layer】:Image elements with the same color will be arrange in series (When laser cutting, will 

complete one color image processing, and then turn to another color. 

 [Inner to outer]: Inner (contained) image will be prior to the outer (containing) image. (When laser cutting, it will 

complete inner image processing, then turn to outer image processing) 

 [Automation set cut director]: Automatically set the image cutting start point and direction when arranging the 

images. 

 [Path run region]：Image arranged according to set [Size] and [Director]. [Path run region] is normally used to 

arrange regular array images, etc, array circle, array rectangle), here the [Size] set to the 

separate image height in the array. 

 

3.13.3 Smooth Objects 

 

Smooth the curve so as to increase cutting speed and stability. 

Click [Tool]/ [Smooth Objects], open dialog box as below then click [OK] 

 
The bigger value the smoothness, the smoother the curve is, but will cause more deformation to the image. 

 

3.13.4 Delete Repeated Lines 

  

[Delete Repeated Lines] allows delete repeated/overlapping images, so machine will not repeat cutting. 

Click [Tool]/ [Delete Repeated Lines], open dialog box as below, and then click [OK] 
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[Repeated Error]: Set value to judge whether 2 adjacent lines are overlapped. 

 

3.13.5 Unite Lines 

 

[Unite Lines] will unite connected multiple segments to single segment. 

Click [Tool]/ [Unite Lines], open dialog box as below and then click [OK] 

 

 [Unite tolerance]: 2 segments will be united to 1 segment if their distances are smaller than tolerance. 

 

3.13.6 Image Invert 

  Click in edit bar, and select the image object to be inverted. Then click [Tool]/ [Image Invert] or click  in 

objects operation bar. 

 

 

Image invert 
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3.13.7 Image Dither 

Click in edit bar, and select the image object to be dithered. Then click [Tool]/ [Image Dither] or click  in objects 

operation bar. 

 

Input [Dot Size], and then click [OK] 

 

3.13.8 Parallel Offset 

  

  [Parallel Offset] is to offset inside or outside the vector graphics data. Select the data to be set, click [Tool] / 

[Parallel Offset] or click on object bar, and open dialog box shown below. 

 
 Select the required parameter, then click [OK], then parallel offset line is created, and offset line will generate a 

new layer automatically shown below: 

Image Dither 
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3.13.9 Estimate Work Time 

 

    [Estimate Work Time] will pre-calculate the processing time according the current parameter settings and image 

data size. The calculation will be very precise, with error no more than 1 min even for image data with heavy work 

load. 

 Click [Tool]/ [Estimate Work Time] or click on object bar, and open dialog box as below. 

  

3.13.10 Simulate 

 

【Simulate】 means simulating the working path displayed.  During simulation, click “+/=”key on keyboard to 

increase displaying speed; Click“－/-”to decrease displaying speed; click “esc” to quit displaying. 

 Click [Tool]/[ Simulate] or click on tool bar, then the image data to be simulated will be displayed. 
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3.14 Default Parameters 

  

When user sets incorrect settings to the software parameter, there could be abnormality to software operation and 

laser output. Resetting software parameters to default will reset all parameter to proper settings (may not be the 

best). 

Note: The operation will not change the parameter housing control card (namely manufacturer parameter and 

user parameter) 

    Click [Options]/ [Default Parameters], and open dialog box as below: 

  

Select [Machine Zero] correctly (The parameter must be the same as actual machine zero, or the processed 

image could be left/right turned or up/down turned), then click [OK] 
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       Chapter 4 Laser Machining 

4.1 Position Relative 

 

 【Position relative】shows the position of laser head relative to figure. 

 Click menu【Options】 /【Position relative】 or click system tool bar ，dialog displayed as below, then click【OK】. 

  
 Following are diagrams with different positions of laser head relative to figure（cross point of two red lines instead 

of laser head）： 
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4.2 Array Output Options 

 Click menu【Options】 /【array output options】or click system tool bar ，dialog displayed as below: 

  

 【Cell width（X）】：Original size of datum 

 【Cell height（Y）】：Original size of datum 

 【Count】：Rows and columns of datum to be output. 

 【offset】：distance between every row or every column. 

 【Width】：Width of all datum after array. 

 【Height】：Height of all datum after array. 



LASER ENGRAVING&CUTTING CONTROLLER AWC608 

 49 

【Auto convert calculation】：According to the space, calculate the rows and columns needed automatically. Click

【Auto convert calculation】, dialog displayed as follows: 

  

【material width(X)】：Width of material to be dealt with（default as width of workbench） 

【material height(Y)】：Height of material to be dealt with(default as width of workbench） 

System will calculate the number of material to be dealt with according to material size. 

The image below is an example of array parameter setting. 

 

 

 

 

4.3 Layer Options 

  

In the process of working, system will control the power, speed and so on of figure in each layer respectively by 

layer options. 
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 View 4-3 

 

4.3.1 Set Layer Parameters (refer to View 4-3) 

 Click “output” column to enable/disable the layer output.  is layer output, is no layer output. 

 Double click any row of layer parameter list（like： ），dialog comes out as 

below: 

  

【Layer】：Indicates current layer need to be altered. Click left layer bar to switch to the layer need to be altered. 

【Work mode】：Includes “cut”，“engrave”，“cut after engraving”，“hole”, if current layer is BMP (like ）it only 

includes “engrave”（It can be only used in engraving）。 
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◆ Cut Parameter 

Select “cut” or “cut after engraving” in【Work mode】, cut parameter is valid as below image:   

 

   【Speed】：Working speed of laser head during cutting. 

【Working power】：Maximum power; To adjust the maximum value of laser power during processing 

layer（Unit:%）. It’s the power of laser 1 of AWC608 control panel. 

【Corner power】：Minimum power; the lowest power value during variable motion. It‘s the power of 

Laser1 of AWC608 control panel. 

  （Make sure laser intensity constant during process by adjusting above two parameters）. 

【Overlap length】：Due to tolerance with machine, probably it will happen that closed image can’t be 

cut off. So this parameter can help to solve this problem. But this parameter should not 

be too large. Suggest adjusting precision of machine to solve this problem. 

   ：Set advanced cutting parameters. Click this button, dialog box displayed as below:  

 
【Working power2】：To adjust the maximum value of laser power during processing layer（Unit:%）. It’s 

the power of laser 2 of AWC608 control panel. 

【Corner power2】： the lowest power value during variable motion. It‘s the power of Laser2 of AWC608 

control panel. 

      【Open delay】：set the delay time before opening laser.。 

   【Close delay】：set the delay time after closing laser. 

 

 ◆ Engraving Parameter 

  Select “engrave” or “engrave after cutting” in【Work mode】，engrave parameter is valid as below image: 
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  【Speed】：Scanning speed during engraving. 

  【Working power】：Adjust size of laser power during processing layer.(Unit: %） 

  【Engrave gap】：Gap between scanning line. 

  【Engrave mode】：Includes “X_swing”, “X_ unilateralism”， “Y_swing”,  “Y_unilateralism” 

X_swing: Laser head releases laser to scan image back and forth in horizontal direction. 

X_ unilateralism: Laser head releases laser to scan image in horizontal direction, but only release laser 

when it’s scanning in one direction. Such as: it releases laser when it’s scanning from right to left, or it 

releases laser when it’s scanning from left to right. 

Y_swing: Laser head releases laser to scan image back and forth in vertical direction. 

Y_unilateralism: Laser head releases laser to scan image in vertical direction, but only release laser 

when it’s scanning in one direction. Such as: it releases laser when it’s scanning from top to bottom, or it 

releases laser when it’s scanning from bottom to top. 

【Grade engrave】：Select “Yes”，【Grade length】and【Min. Power】are valid. Grade engraves is shown as 

below: 

 

  【Grade length】Show the “grade” in the graphic. 

【Min. Power】：Minimum value of laser power during adjusting grade engraves. This value confirms the 

depth of grade. 【working power】confirms depth of engraving  

 

 ◆ Hole parameter 

Select “hole” in【Work mode】，hole parameter is valid as below: .  Click【hole parameter】, 

dialog box is displayed as below: 
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 【Speed】：Moving speed of laser head. 

 【Power】：Adjust size of laser power during processing layer. (Unit: %） 

 【Interval】：distance between holes. 

 【Time】：waiting time of laser head when punching holes. 

 

4.3.2 Adjust Layer Working Sequence (refer to View 4-3) 

 

 Processing sequence in layer list is from top to bottom. If need to change the processing sequence, just need to 

select one row of them and then click or or or  

Note: Only if the 【Layer Sequence】is selected from path optimization parameter, the layer working 

sequence can be valid. 

 

4.4 Machine Control 

 

 【Machine control】is to finish downloading of Image, starting & processing and some simple machine operation 

control. 

 View 4-4 

4.4.1 Download image data & machine documents management (Refer to view 4-4) 

  Click  to open dialog box as below: 
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 View 4-4-1 

 

4.4.1.1Download current file data (image data of software) to the Machine (Refer to view 4-4-1) 

 

◆Current documents options 

 【Current documents options】means the options of document to be downloaded to main board. 

 【Name】：Document Name to be downloaded to main board 

【Work Times】：The amount of times you want the task to be done.  System will repeat the task of downloaded 

document automatically when started. 

 【Repeat Delays】：Delay time after 1 task when applying multiple tasks. 

  ：Set document advance options. Click this button to open dialog box as below, then click [OK] 

   

【Feed Length】：Moving distance of feeding axes(Z-axes) after each task completed. 

 ◆ Document Data Optimize 

     【Document Data Optimize】: Will optimize settings of the current document. 

【Gap Optimize】: Select this option then system will confirm the cutting direction automatically to offset 

mechanical reverse clearance when cutting complicated image, but will increase the 

space work move distance greatly, so generally the option is not recommended. 

【Line Cut Mode】: The option is to avoid power ”repeated point” during corner cutting, and effective to 

material cutting such as adhesive material. But this will affect the work efficiency, so generally 

the option is not selected. 

【Re-order Objects】: System will apply [Automatic Order] to document data when this option is selected. 

(【Automatic Order】introduction, please refer to 3.13.2) 
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◆ Document Export 

(1) Save data as offline files (*.ud5 files),then copy to control panel via U disk 

Click [Save document to Ufile] to open dialog box: 

 

Input file name, and click [Save] 

(2) Download document to control panel directly via USB or internet communication, 

Click [Download document] 

4.4.1.2 Machine Document Management (Refer to 4-4-1) 

 

Manage files saved in memory of main board. 

【Refresh】：means checking all files saved in main board. Click ，all files saved will be shown in file 

list, and then [Work][Delete][All Delete] will become valid. Shown as below: 
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 [Work]: Select one file in the file list, click [Work] button to start the work. 

 [Delete]: Select one file in the file list, click [Delete] button to delete the file in the main board memory. 

 [All delete]: Delete all files saved in main board. 

 [Format]: Format main board memory. All files saved in main board will be lost. 

[Download Ufile]: Download offline files (ud5 file) saved in computer to the main board. Click [Download Ufile] to 

open dialog box, select the file to be loaded then click [Open] 

 

4.4.2 Machine Control (Refer to view 4-4) 

  
 【Origin】: Set the current laser head position as origin 

【Start】： Start work for the current selected file in control panel 

【Use/continue】：Click 【Use/continue】 to suspend or continue the work. 

 【Stop】: Stop working of machine 

【Run box】: Laser head will run rectangle shape according to the size of file data. The option is mainly used to 

confirm the placed position of parts to be processed 

【Clip box】: Cut completed part from working material 

【Light】：Press/Release [Light] to turn on or turn off the laser. 

【Datum】: Click the button, laser head（or z-axes） will move to machine origin slowly, when reach the limit 

position of machine, will move quickly to located position. This can get rid of cumulative errors, and shall apply 

for one time before starting work normally. 

【X-】【X+】【Y-】【Y+】【Z-】【Z+】： Move laser head(or Z-axes)。Press the button, laser head (or Z-axes) starts 

Four files are currently saved in mainboard 
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to move; Release the button, laser head(or Z-axes) stops moving. 

 

        Chapter 5  CorelDraw Based Software 

5.1 Manual Download Tool“AWCLaserCut” 

 

After installation of CorelDraw direct output, (refer to Chapter 2 Installation of Software）, start CorelDraw, Main 

interface of CorelDraw12 shown as below: 

 

 （1） Click menu【Tool】/【Macro】/【Run Macro】 as follows: 
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 （2） Dialog displayed as follows: 

 

 

 （ 3 ） At 【 Mocras in 】 select “AWCCorelEx.Gms” or” AWCCorel12.Gms”, then at 【 Mocra name 】 select 

“AWCLaserCut.AWCInit ” as follows: 

 

 

（3） Click【Run】, main interface of CorelDraw can add tool “AWCLaserCut” as follows: 
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 （5）Use mouse to drag tool “AWCLaserCut” to toolbar as follows: 

 

 （6 ）After manual loading tool “AWCLaserCut” in CorelDraw, then re-start CorelDraw, “AWCLaserCut” Tool will 

display in toolbar. 

5.2 Display hidden tool “AWCLaserCut”  

 User will close tool “AWCLaserCut” carelessly during using CorelDraw, so hidden tool should be displayed, 

operation as follows: 

 Right click toolbar to display a list, then click【AWCLaserCut】 as follows: 

“AWCLaserCut”toolbar 

“AWCLaserCut”toolbar 
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5.3 Import DST/DSB file 

 Click import button  of tool “AWCLaserCut”, dialog displayed as below: 

 

Select DST/DSB file to be imported, then click【Open】. 

 

5.4 Switch CorelDraw to LaserCAD 

 Edit diagram in CorelDraw as follows: 
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Click   to switch to LaserCAD directly. And edited diagram in CorelDraw will display in the view of LaserCAD as 

follows: 

 

In this case, we can complete laser machining by LaserCAD. 
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Chapter 6  AutoCAD Based Software 

6.1 ADD AWCLaserCut toolbar. 

After installation of AutoCAD direct output, （refer to：Chapter 2 Installation of Software）, start AutoCAD, the 

main interface doesn’t display menu【Laser machining】and tool【Laser machining】, at the moment; it should be 

downloaded manually. Operation as follows: 

（1） Click menu【tools】/【Macro】/【Macro】, shown as below: 

 
（2） Dialog displayed as follows: 

 

（3） In【Macro name】 to select“…AWCLaserCut.AWC_Init_EN”, and then click 【run】,menu “AWCLaserCut” 

and tool ”AWCLaserCut”, as follows: 
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6.2 Switch AutoCAD to LaserCAD 

 

 Edit diagram in AutoCAD as follows: 

 

Click menu【AWCLaserCut】/【LaserCut】, or click to switch to LaserCAD and edited diagram in AutoCAD 

will display in the view of LaserCAD as follows: 

AWCLaserCut toolbar 

 

AWCLaserCut Menu 
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In this case, we can complete laser machining by LaserCAD. 

      

      

   Chapter 7 Introduction Manual of LCD Panel 
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7.1 Function introduction to each key 

1.  “Reset” Key: Press this key, machine can enter into the state of reset under at anytime, and then go 

back to “Original point” 

2.  “Laser” Key: Used to test Optical path. Press it to flash. 

3.  “Menu” Key: Press this key to enter into main menu. 

4.  “Box” Key: Used to test the size of graphic to be cut and test the current original point. 

5.  “File” Key: Working files saved on control panel 

6.  “Origin” Key: Can set starting point of machine 

         

7. Esc” Key: Press to cancel operation and go back to last interface. 

8.  “Stop” Key: Stop running machine. 

9.  “Enter” Key: Press key to agree current operation. 

10.  “Start/Pause” Key: Start to operate current file, it can realize stopping and continuing of running 

machine.  

11. Key: It can be used to move motion axis, move cursor in current view, and also alter 

the number value in view. 

12. “Z/U” Key: Autofocus and Z/U-axis moving, Z-key is lifting axis, U-key is feeding axis. 
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7.2 Interface of starting computer 

Interface of starting computer shown as below: 
                 

 

 

 

 

 

 

 

   After initialization, it enters into main interface shown as below: 

 

【file】：show serial number of files. 

     【Num】：show times of current diagram after adding one by one. 

【Power 1】：Machining graphic, set the percentage of laser power; former number is maximum power 

(In-process power), the latter number is minimum power(power when turn around) 

【power 1】can be switched to【power 2】 shown as below: 

          

    

     【speed】：Speed value set during machining graphic 

  【X】：show X-axis value of laser head with machine 

  【Y】：show Y-axis value of laser head with machine 
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7.3 Function introduction to main interface 

 View 7-3 

Under the main interface, press , cursor will appear on one item selected show as below: 

  

 When there is no cursor, system is in state of “Key moving“; when there is cursor, system is in state of “parameter 

modification”. 

In the state of “Key moving“: 

(1) press , cursor will appear and system will enter into state of “parameter modification”； 

(2) press or to move X-axis, press or to move Y-axis 

 In the state of “parameter modification”: 

(1) Press , cursor will disappear and system will enter into state of “Key moving“. 

(2) Press or or or to select other items, then press to enter into sub interface 

to modify parameter.  

 

7.3.1 Check and Alter the properties of current file (refer to view 7-3) 

 

7.3.1.1 Check the properties of current file 

 Press , cursor appears on main interface, press or or or to move cursor onto item
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【file】: 

  

 Press to enter into properties sub interface of file: 

 View 7-3-1-1 

7.3.1.2 Alter the properties of current file 

 Take modifying the【Repeat count】 of file for example, to explain how to modify the properties of files. Refer to 

view 7-3-1-1, press or to move cursor onto item【Repeat count】 and then press ： 

  

 Press or to move cursor onto a digit, and then press or to modify the number.  After modification, 

press to finish the modification of 【Repeat count】. 

   

7.3.2 Clear total working times of file (refer to view 7-3) 

 Press , cursor appears on main interface, then press or or or to move cursor onto item
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【Num】: 

  

 Press to enter into sub interface: 

  

 Press to clear total working times of file. 

 

7.3.3 Switch between “Power 1”&“Power 2” (refer to view 7-3) 

 Press , cursor appears on main interface, press or or or to move cursor onto item

【power】: 

  

 Press  to enter into sub interface: 



LASER ENGRAVING&CUTTING CONTROLLER AWC608 

 70 

  

 Press to move cursor onto item【Laser 2】，then press : 

  

 Similar operation can also switch “power 2” to “power 1”。 

 

7.3.4 Change speed, Maximum power, Minimum power (refer to view 7-3) 

 Press , and cursor appears on main interface, press or or or  to move cursor onto 

item【speed】: 

  

 Press to enter into sub interface: 
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 Press or to move cursor onto one number, and then press or to modify the number after 

modification, press to finish the modification of 【speed】. Similar operations can modify【maximum power】, 

【minimum power】. 

 

7.4 Main menu function 

 Press  to enter into main menu interface. 

 View 7-4 
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 Under the main menu interface, press or or or  to move cursor onto one item. 

 

7.4.1 UDisk file (Refer to View 7-4) 

 This UDisk file system only supports FAT32. 

 Under the main menu interface, move cursor onto【UDisk file】, press to enter into 【Disk file】interface 

(User must insert U-disk into U-disk interface in control board of AWC608)

 View 7-5 

 

7.4.1.1 Work file (refer to view 7-5) 

 Under the 【UDisk file】, press or  to move cursor onto item【work’ files】, press to enter into 

【work’ files】 interface: 

  

 Press or or or to move cursor onto one file, and then press , system will copy the file 

into the memory of control panel. Then this file can be output. (suffix of work file is ud5) 

 

7.4.1.2 Config File (refer to View7-5) 

 Under【UDisk file】interface, press or  to move cursor onto item【Config’ files】,after pressing to 

enter into 【Config ’ files】interface, move cursor to select one parameter file, and then press , system will 
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update the parameter of control panel according to parameter file.(suffix of parameter file is cf5). 

 

7.4.1.3 System upgrade file (refer to graphic 7-5) 

 Under【UDisk file】interface, press or  to move cursor onto item【Upgrade’ files】.After pressing  

to enter into【Upgrade’ files】,move cursor to select one upgrade file, and then press , system will upgrade 

according to upgrade file. System will go to state of reset after upgrade finished. During update, don’t cut power of 

control panel. Otherwise it will damage the system. (suffix of system upgrade file is ug5)。 

 

7.4.1.4 Save Current parameter to UDisk(refer to graphic 7-5) 

 Under【UDisk file】 interface, press or  to move cursor onto item【Curr config to UDisk】 . 

Press , system will copy a parameter of control panel into U-disk. The file name is Params.cf5。 

 

7.4.2 Parameter Option(refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【Params Option】. 

Press to enter into 【Params Option】interface; 

  

  【KeyMove' speed】: Traveling speed of key on LCD panel. 

  【RunBox’ speed】: Traveling speed around graphic border. 

  【CutBox’ speed】:Cutting speed on graphic border. 

  【FocusDistance】:Autofocus distance of Z-axis. 

 Press or to move cursor onto one item, press to enter into sub interface, and then 

press or or or  to modify the value. Then press  to finish the modification of this 
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parameter. 

 

7.4.3 Origin manage (Refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【Origin manage】, 

then press to enter into【Origin manage】interface: 

  

 Press or to move cursor onto one item, and then press : 

  

Move cursor onto item【move to origin1】, and then press , system will move laser head to the original 

position 1 (X=20.0mm，Y=30.0mm). 

Move cursor onto item [Current as Origin1], and then press , system will set the position of current 

laser head as origin position 1. 

Move cursor onto item 【origin 1(X)】or item【origin 1(Y)】, then press , it will enter into sub interface 

to do modification manually on coordinate of origin position. 

 

7.4.4 Origin Mode (Refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item【Origin mode】, then 
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press to enter into【Origin mode】interface: 

  

  【Key origin】：Take the original point selected by of LCD panel as beginning. 

    【Soft origin】：System will work according to the position of data on coordinate of software.   【 Machine 

zero】：Take zero point of machine (limit point) as beginning. 

 Press or to move cursor onto one item, then press  to set specific orientation mode 

 

7.4.5 Control Mode (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item【control mode】, 

press to enter into 【control mode】interface: 

  

【Soft layer params】：Using the layer parameter set in software ( LaserCAD) to deal with graphic and data. 

(Including: speed, maximum power and minimum power of laser 1, maximum power and minimum power of 

laser 2)(Regarding the instruction of layer parameter, please refer to 4.3 layer parameter) 

【LCD Panel params】：Using the parameter set in the main interface of LCD panel to deal with graphic and 

data. (Including: speed, maximum power and minimum power of laser 1, maximum power and minimum 

power of laser 2)(Regarding the instruction to the main interface of LCD Panel, please refer to 7.3 function 

instruction of main interface.) 
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 Press or to move cursor onto one item and then press  to set parameter control mode 

 

7.4.6 Memory management (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【Memory manage】, 

press to enter into 【memory manage】interface: 

  

  【format memory】: format the memory of control panel, it will delete all files saved in control panel. 

 【check memory】: check memory of control panel, it will delete all files saved in control panel. 

 Press or to move cursor onto one item, and then press to do relevant operation 

 

7.4.7 Axes Control (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【Axes Control】, 

press to enter into【Axes Control】interface: 

  

  【Z axis reset】：Z-axis starts to move to reset 

  【Z Origin:2.0mm】：the mobile distance of Z-axis in opposition direction after reaching limit. 

【U axis reset】; U-axis starts to move to reset. U-axis can’t reset when U-axis is feeding axis (Regarding 

the function and configuration of U-axis, please refer to 3.3.2.4 Function and configuration) 

  【U axis orgin:3.0mm】：the mobile distance of U-axis in opposition direction after reaching limit. 
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 Press or to move cursor, and then press to do operation and setting 

 

7.4.8 Inching control (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item【Inching control】, 

press to enter into 【Inching control】interface: 

  

 Press to move cursor to select one item 

When select item【XY inching】, press or to move laser head by length of 【inching distance】in the X 

direction, press or to move laser head by length of 【inching distance】 in the Y direction. 

When select item【Z/U inching】, press or  to move laser head by length of【inching distance】in the U 

direction, press or  to move laser head by length of 【inching distance】 in the Z direction. 

When select item【inching distance】, press  to enter into sub interface to set【inching distance】. 

Under 【inching control】interface, press  to go back to the main menu interface. 

7.4.9 Cut box (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item【cut box】, then 

press to enter into 【cut box】interface: 
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  【blank 】:The distance between border of graphic and border of cut part. 

 Press or to move cursor onto one item 

 When select item【cut box】, press , system will cut outline border at the speed of 【Speed of cutting 

border】 and at the power set in the main interface (Regarding【Speed of cutting border】, please refer to 7.4.2 

parameter setting; Regarding the power in main interface, please refer to 7.3 function instruction of Main interface) 

 When select item【Blank】, press to enter into sub interface to set【blank】. 

 

7.4.10 Network Config (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item【Network config】, 

and then press to enter into 【network config】interface: 

  

 Press or to move cursor onto one item, then press to enter into sub interface to modify this 

value 

 （Regarding more content of network communication of computer and control panel, please refer to 3.2.2 Select 

network communication mode） 
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7.4.11 Languages (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【language】, and 

then press to enter into 【language】interface: 

  

 Press or to move cursor onto one item and then press  

 

7.4.12 System Version (refer to view 7-4) 

 Under the main menu interface, press or or or to move cursor onto item 【system version】, 

press  to enter into 【system version】interface: 

  

 Version of 【Main Board】can be upgraded by【UDisk file】to the newest one. （Refer to 7.4.1.3 System upgrade 

file） 

  

7.5 Z/U axis 

 Under the main interface, press : 
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 Press or  to move cursor to select one item 

 When select【Auto focus】and press , Z-axis will move at the speed of 【Z-axis reset speed】(Refer to: 

3.3.3.2), stop till touch Z+ limit switch, and then move the distance as in【Focus distance】in opposite direction.(Refer 

to: 7.4.2) 

When select【ZU move】, and press or , Z-axis starts to move, release or , Z-axis stops moving. 

Press or , U-axis starts to move, release or , U-axis stops moving. 

 

7.6 Files system 

 Under the main interface, press  to enter into 【file】interface: 

  

  In【file】interface, it will show all working files saved in the memory of control board. 

 Press or or or to move cursor on one item and then press  
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 Press or  to move cursor to select one item 

 Select【select】, and press , system will select files and go back to main interface. In main interface, the 

file sequence number will be shown in【file】; Press  in main interface will start files output. 

Select【delete】, and press , then files will be deleted. 

 Select【copy to UDisk】, and press , then files will be copied to UDisk（UDisk only support FAT32）. 


